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Disclaimer: 
 

1. The manufacturer and/or its agents take no responsibility for any 
damage, financial loss or injury caused to any equipment, property or 
persons resulting from the correct or incorrect use of the Inner Range 
system and its peripherals. The purchaser assumes all responsibility in 
the use of the Inner Range system and its peripherals. 

2. Whilst every effort has been made to ensure the accuracy of this 
manual, Inner Range Pty Ltd assumes no responsibility or liability for 
any errors or omissions. Due to ongoing development the contents of 
this manual are subject to change without notice. 
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Quick Start 

This section gives you the minimum information needed to get Insight running quickly. For more 
information, refer to the rest of the Guide. Whilst using Insight, pressing the F1 key will open 
electronic help. 

You Will Need 

1. A workstation with Windows 2000 or Windows XP installed and 100Mb of free disk. 
2. A spare USB port on the Insight Server computer (not needed for Insight Lite). 
3. Version 5 firmware upgrade kits for all version 4 panels you intend to manage with 

Insight. 

Step 1: Install Insight Lite 

1. Locate the Insight Lite install 
program and open it. 

2. Follow the on-screen prompts. 
3. Click Finish. 
4. Restart your computer if you 

are asked to do so. 
 

- or - Step 1: Install Insight Professional 

1. DO NOT plug in the USB hardware 
lock until you are instructed to do so. 

2. Locate the Insight Professional install 
program and open it. 

3. Follow the on-screen prompts. Only 
choose “Client and Server” on the 
computer that will be the Insight 
Server. For all other workstations, 
choose “Client Only”. Be patient, 
installation might seem to pause for 
up to 5 minutes. 

4. Click Finish. 
5. Plug in the hardware key. 
6. Restart your computer if you are 

asked to do so. 

Step 2: Enrolling a Version 4 Panel 

If your panel is already version 5, skip to step 4. Otherwise: 
 

1. Configure a PCDirect comms task in the panel.  
2. Start Insight Launch Pad (page 9), then click the Enrol Panel icon. 
3. Log in as admin / admin. 
4. Enter the details of your panel (page 19). Make sure you set the protocol to PCDirect. 
5. Click Enrol Now. 

Step 3: Upgrading a Version 4 Panel to Version 5 

1. Upgrade your panel to version 5 firmware. Detailed instructions are available from Inner 
Range (document part number 635101; if you bought Insight Professional then this 
document can be found in the box). Important: ensure jumpers LK8 and LK9 are set 
correctly as per the diagram. Don’t forget to jumper LK2 according to your RAM size 
(top two pins for 128k and 512k, bottom two pins for 32k). 

2. Default the panel from a terminal (menu 7-5-2). Use the 
memory configuration that was uploaded in step 2. 

3. Start Insight Edit (page 10). 
4. Locate the panel in the Insight Toolbar (page 13). 
5. Right-click the panel and choose “Properties” in the menu 

that appears. 
6. Tick the box that says “I have upgraded my panel to Version 

5”, then click OK. 
7. If you are using a direct serial connection, and you used a 

baud rate other than 9600 for PCDirect, right-click the panel 
and choose “Properties” in the menu that appears. Click 
Ports. Click Serial.  Set the baud rate back to “9600” and 
click OK. 

8. Right-click the panel, choose “Entire Panel” in the menu that 

1 

2 

3 

LK
8 

LK9 

RAM

Firmware

LK2 
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appears, then choose “Mark For Download”. The panel turns red, indicating there are 
records waiting to be written to the panel. 

9. Go to step 5. 

Step 4: Enrolling a Version 5 Panel 

1. Configure an Insight comms task in the panel (see page 65 for the settings to use). It 
must be comms task 1. 

2. Start Insight Launch Pad (page 9), then click the Enrol Panels icon. 
3. Log in as admin / admin. 
4. Enter the details of your panel (page 18). Make sure the protocol is set to Insight. 
5. Click Enrol Now. 

Step 5: Connecting the Panel 

1. Start Insight Edit (page 9). 
2. Locate the panel in the Insight Toolbar (page 13). 
3. Right-click the panel and choose “auto connect” (page 24). The panel icon turns green. 

(If you followed steps 3 and 4, then the panel turns blue while Insight downloads all 
records into the panel). If you cannot connect, refer to troubleshooting on page 20. 

4. Set the panel date and time (page 25). 

Step 6: Make Programming Changes 

1. You can make programming changes with Insight Edit (page 27). You select the item 
you want to program using the browser (page 28) and editing windows (page 32). 

2. If you make edits while the panel is not connected, the panel turns red in the Insight 
Toolbar (page 33). Changes will be sent to the panel when it is next connected (page 
24). 

Step 7: Examine Review 

1. Review is automatically downloaded whenever a panel is connected (page 23), but you 
will not be able to see the review unless you use Insight Review (page 39). 

2. To see review, open a new review window (page 41) and click the Go button (page 41). 
3. The default filter shows review events that were generated in the last 24 hours. If you 

forgot to set the panel date and time, no review will be visible. If you want to see all 
review, change the filter to “All Review” (page 42), or select filters that suit your 
requirements (page 42). 

Step 8: Further Reading 

This concludes the Quick Start section of this Guide. Refer to the following chapters to unlock 
the power of Insight in more detail. Don’t forget - pressing F1 will open context sensitive help at 
any time within Insight. Thank you for using Insight! 

4 

5 

6 
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Introducing Insight 

Insight is very different to PCDirect and WinDirect. Insight consists of seven modules. Each 
module is a separate program that helps you manage an aspect of your Inner Range 
installation. The seven modules are (in the order you will probably use them): 
 
Icon Module Description 

 

Launch Pad Launch Pad is a central springboard that lets you quickly 
navigate to the other Insight modules. 

 

Insight Edit Insight Edit lets you inspect and modify the programming 
of your Inner Range system. 

 

Insight Review Insight Review lets you examine live and archived panel 
review, and generate reports. 

 

Insight Archiver Insight Archiver provides a one-click backup solution for 
your Insight security database. 

 

Licence Manager Licence Manager activates paid features. 

 

Insight Operators 
Insight Operators lets you manage access rights and 
privileges of employees who can logon to the Insight front-
end. 

 

Insight Schematic 
Insight Schematic allows operators to monitor the status of 
an installation via an intuitive interface based around 
graphical floor plans and site maps. 

 
 

Warning 
Insight is compatible with version 5 panel firmware. You can determine the firmware of your 
panel by pressing MENU-2 on any Elite Terminal. The only operation that can be performed on 
version 4 panels is enrolment. You cannot change programming, control devices or read review 
from version 4 panels. After enrolling a version 4 panel, upgrade the firmware to version 5 so it 
can be managed with Insight. See page 5. 

Paid Feature 
License Manager, Insight Operators and Insight Schematic are not available in Insight Lite. 
 

V 
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Product Highlights 

Connectivity 
� Insight is a true multi-panel, multi-workstation system. 
� Insight uses Octane™ compression for fast upload/download, even over slow links. 
� Supports direct serial and internal modem connections. Future releases will add support 

for external modem and TCP/IP connections. 

Editing 
� Changes to module programming take effect immediately, without a LAN secure. 
� The LAN status of modules, zones and auxiliaries is displayed. 
� Selectively show or hide items based on: 

o Name 
o LAN status (secured, missing, unexpected, not installed) 
o Programming status (blank, programmed, queued for upload/download) 

� You can have multiple forms open at the same time. 
� Single-click hyper-linking between forms (“help-9 / help-0” functionality). 
� On-line data comparison between the front-end database and any panel. 
� Automatic detection of edits made at any Elite Terminal. 

Management 
� Perform full or partial uploads and downloads. 
� Upload individual records. 
� Full support for offline editing.  

Control 
� Remotely control areas, area lists, auxiliaries, auxiliary lists, doors, door lists, floors, 

floor lists, home auxiliaries and zone inputs. 

Online Help 
� Comprehensive context sensitive help. Press F1 for help on any screen! 
� Helpful tips are shown when each module starts. These can be turned off if required. 
 
 

Installing Insight 

Refer to the Quick Start guide on page 5. 
 

Registering Insight Professional 

Insight Professional must be registered within 30 days of installation. See page 47 for more 
information. 
 

Insight Professional (Demo Edition) 

Insight Professional is available in a demonstration edition. This version is identical to Insight 
Professional, with five exceptions: 
 
� Operator passwords are bypassed. 
� Only the first five items of each type are visible (doors, areas, users, maps etc.) 
� You are logged off every two hours. 
� A different type of hardware lock is used. 
� Licence Manager is not available. 
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Launch Pad 

Launch Pad is the “command centre” of Insight. It is a module that lets you quickly navigate to 
all other modules. When you close Launch Pad, it moves to the system tray for easy access 
(next to your clock in the Windows task bar). 
 
Launch pad also lets you specify key Insight settings such as when Operators need to log on. 
 

  
 

• The launch buttons let you launch other modules with one button click. 
• The tip window provides information about each module. Point your mouse over a 

launch button for a description of that module. 
• The wallpaper improves the aesthetics of Launch Pad. You can select from a library of 

default wallpapers, or choose your own. 
 

Starting Launch Pad  

You can start launch pad in two different ways: 
 

1. Click the start button and choose Programs → Inner Range → Insight → Insight 
Launch Pad 

2. When you start your computer, Launch Pad appears automatically in the system tray 
(next to your computer clock). Click the icon. 

 
Tip 
If Launch Pad is running, you can access it from the system tray. Click the Insight icon to open 
it. (On Windows XP, you may need to click the 33  button to display all icons.) 
 
 

 

� 

Tip Window 

Launch Buttons

Wallpaper
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Launching a Module  

You can start a module in one of four ways. Choose the one that is most 
convenient for you. 
 

1. Click the module icon with the mouse. 
2. Right-click the launch pad icon in the system tray, and in the pop-

up menu that appears click the name of the module you want to 
launch. 

3. Click the Launch menu, and then click the module you want. 
4. Hold down the control key, and then click the number key that corresponds to that 

module. (See the Launch menu for the number assignment of each module.) 
 
The module is launched. You may need to log in to the module with an operator name and 
password. 
 
Tip  
You can run multiple different modules simultaneously - you don’t have to quit a module before 
starting another module. If a module is already open, then attempting to launch another copy 
activates the open module instead. 

Logging In 

You have to log on as an operator before you can use any module. 
When you start a module, you are prompted to enter your operator 
name and password.  
 

1. Enter admin as the operator name. 
2. Enter admin as the password. 
3. Click Log On. 

 
 

Changing Launch Pad Preferences 

You can customise aspects of Launch Pad. 
 

1. On the Edit menu, click Preferences. 
2. Make your changes. 
3. Click Save or Apply. 

 
The settings are: 
 

• Play Sounds: clear this check box if you do not want to hear a beep as the mouse 
moves over a launch button. 

• Wallpaper: change the appearance of Launch Pad. Choose from a library of built-in 
wallpapers, or choose your own. You can also fade the wallpaper to make it less 
obtrusive.  

Tip 
Settings are saved per operator. If you log on to launch pad, your previously saved settings are 
restored. When launch pad starts, no operator is logged in. You can still change preferences, 
which will be restored the next time launch pad is started. 

� 

� 
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Changing Client Settings 

You can change Insight settings for your workstation. These 
settings apply universally to all modules on the workstation. 
 

1. On the Tools menu, click Insight Client Settings 
2. Make your changes. 
3. Click Save or Apply. 

 
The settings are: 
 

• Server 
o Server Address (not available in Lite): 

specifies which computer is running the 
Insight Database Server. If Insight is installed on a single computer, or if this 
computer is the server in a multi-computer installation, then select “This 
Computer”. If this computer is not the server in a multi-computer installation, 
click “another computer” and enter the name or IP address of the server 
computer. 

• Logging 
o Specifies diagnostic logging options. Do not modify these settings unless 

instructed by an Inner Range technician. 
• Client 

o Client Options: tick this option if you want Launch Pad to appear whenever an 
Insight module is closed. 

o Password Caching: specifies when Operators must enter their password. If 
caching is enabled, then Operators do not need to enter their name and 
password until they quit a module, at which point the cache is cleared. If 
caching is disabled, then Operators must enter their password every time a 
module is started. 
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The Insight Toolbar 

The Insight Toolbar is the management centre of Insight. The toolbar is where you create and 
manage sites, enrol panels, control field devices and perform panel programming and 
maintenance. The Insight Toolbar is available in all modules. 
 
Use the Insight Toolbar to: 
 

• Enrol panels 
• Connect and disconnect panels 
• Create master sites and sub-sites 
• Copy or move panels between sites 
• Import, export and duplicate panels 
• Perform selective upload and download 
• Remotely control hardware and modules 

 

 
 
 
 

• The Site Tree displays all the sites and panels being managed by Insight. 
• The gripper lets you undock (float) the toolbar, move it around, or dock (anchor) it. 
• Use the tabs to select different modes of the Insight Toolbar (page 25). 

 

Tabs 

Master Site Panel 

Site Tree 
Sub-Sites 

Gripper 
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Working With Sites 

When using Insight, you organise your panels into 
collections called sites. A site is a “container” for adding 
panels. When you create a site, you specify a name and 
some contact details. 

Tip 
Sites don’t have to correspond to actual, physical sites. 
You may wish to have a new site per customer, or you 
may want to group your panels by geographic area, or 
you may choose to store all of your panels in one site. 

Tip 
When Insight is installed, it creates a single site called 
“Default Site”. 
 

Previous Software 
In PCDirect and WinDirect, sites are called clients. Sites are more powerful, because: 

• One site can hold more than one panel. 
• Sites can be contained within other sites, forming a ‘hierarchy’. 

Master Sites and Sub-Sites 
If a site is contained within another site, it is called a sub-site. Sites that are not contained by 
other sites are called master sites. 

Paid Feature 
You cannot create sub-sites in Insight Lite. 
 
 

To Create A New Master Site 
 

1. Right click the blank white area below the bottom of the Sites Tree, and choose “New 
Master Site…” in the menu that appears. (Tip: you may have to scroll to the bottom of 
the Site Tree to find the blank area.) 

2. Enter a unique name for the site. 
3. Click OK. 

To Create A New Sub-Site (licensed versions) 
 

1. Right click an existing site and choose “New Sub-Site…” in the menu that appears. 
2. Enter a unique name for the site. 
3. Click OK. 

Operator Permissions 
To create a new master site, you must have the create permission for sites. To create a new 
sub-site, you must have the create permission for sites and the change permission on the 
parent site.  
 

To Edit Or Rename An Existing Site 
 

1. Right click the site and choose “Properties…” in the menu that appears. 
2. Edit the details of the site. 
3. Click OK. 

� 
� 
 

 

; 
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Operator Permissions 
To edit or rename a site, you must have the change permission on that site.  
 
 

To Move A Sub-Site (paid versions) 
 

1. Click the site you want to move, and keep the mouse button down. 
2. Drag the site into its new location. 
3. Release the mouse button 

 
Panels are moved with the site. You cannot move a site into a different master site. 

Operator Permissions 
To move a sub-site, you must have delete permission on the site being moved and change 
permission on both the old and new parent sites.  

; 

; 
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Working With Panels 

You cannot work with a panel until it has been created in Insight. There are three methods of 
creating panels: 
 

1. Enrolling: this is the normal method. The panel is physically connected, and is fully 
uploaded into Insight. 

2. Importing: with this method, the operator specifies a template file that is loaded into 
Insight. The panel is connected later on for full or partial download from the template. 

3. Copying: the programming of an existing panel can be duplicated, creating a new 
panel. The programming of the new panel can then be fully or partially downloaded later 
on. 

Tip 
Insight ships with a number of “empty panel” templates, including Standard, Enlarged, Access, 
Access 2, Alarms, Apartments, Extra Door and Special. You can use these templates as a basis 
for panel programming without enrolling an empty panel. 

Warning 
Once you enrol a panel into a particular site, it can only be moved amongst sites in the same 
master site. You cannot move a panel from within one master site to another master site. Make 
sure the desired master site exists before you enrol panels. 

Note 
Panel connections are always made through Insight Server. For direct serial connections, the 
panel must be connected to the server computer. For dial-up connections, the PC modem must 
be connected to the server computer. 

Paid Feature 
By default, you can only manage one panel with Insight Professional . If you want to manage 
multiple panels with Insight Professional, you must purchase a multi-panel licence. 
 

Enrolling Panels 

Enrolling a panel makes the panel available in Insight, and 
also uploads (reads) all of the existing programming and 
users from the panel. To upload a panel: 
 

• The panel must be powered on. 
• Insight must be able to communicate with the panel 

(via direct serial, dial-up or TCP/IP). 
• A comms task must be configured in the appropriate 

format. For PCDirect, consult your programming 
manual. For Insight, see page 65. 

To enrol a panel: 
 

1. In the Insight Toolbar, decide which site will contain 
the panel. If necessary, create a new master site or 
sub-site. 

2. Right click on the site that will contain the panel, and choose “Enrol Panel…” in the 
menu that appears. 

3. The Enrol Panel window appears. Enter the correct information for the panel being 
enrolled (see following pages). 

4. Click the Enrol Now button. A new window appears, showing enrolment progress. 
 

� 
V 
� 
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Note 
Some of the settings on the enrolment screen must match the equivalent settings in Insight, or 
enrolment will fail. For your convenience, these fields are marked with a small Control Module 
icon (     ). Double-check that these settings match the settings in the panel. 

Note 
You can only enrol panels from the Insight Server computer. You cannot enrol panels from an 
Insight Client computer. 
 

Operator Permissions 
To enrol a panel, you must have the create permission for panels and the change permission 
on the containing site. The permissions for the new panel are copied from the defaults tab of 
each Operator Type.  

Previous Software 
Uploading a panel in WinDirect and PCDirect was a very time consuming task. Insight uses 
Octane™ compression to upload the panel many times faster. Depending on panel contents 
and transfer conditions, Insight can upload up to 1000% faster than PCDirect / WinDirect. 
 

If you are enrolling a version 5 panel: 
 

Name: Enter a name for the panel. 

Panel ID: Enter the 8 digit panel identification number. This number 
must match the panel ID specified in the Insight comms 
task. 

Serial Number: Enter the panel serial number (press MENU-2 on any 
terminal). You must enter the number exactly as it appears, 
including leading zeros. 

Add To Site: Shows the site that will contain the newly enrolled panel. 

Encryption Key: Enter the encryption key for this panel (exactly 32 digits). 
This number must match the Insight A & Insight B fields 
specified in the Insight comms task. Leaving this field blank is 
equivalent to selecting all zeros. 

Connection: Specify the connection method you will use to enrol the 
panel. 

• Ethernet→Panel Ethernet UART: select this option if 
you wish to use your computer’s TCP/IP network 
connection or the Internet, and the panel is fitted with 
a TCP/IP Ethernet UART board. 

• Serial Port→Panel UART: select this option if you are 
using a direct serial connection between Insight 
Server and the panel, or if you are using a serial to 
TCP/IP protocol converter (e.g. Lantronix). 

• PC Modem→Panel External Modem: choose this 
option if you wish to use a modem on the Insight 
Server computer to dial an external modem on the 
panel. 

• PC Modem→Panel Internal Modem: choose this 
option if you wish to use a modem on the Insight 
Server computer to dial the internal modem on the 
panel. 

Settings: Specify any additional connection parameters here. Settings 
such as baud rate and IP address must match those of the 

� 
� 
; 
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panel. 

Panel Server: Do not change this setting from ‘LOCAL’. 

Protocol: Set this to Insight. Make sure comms task 1 is configured as 
Insight (page 65). 

Installer PIN: This field is ignored and may be left blank. 

If you are enrolling a version 4 panel: 
 

Name: Enter a name for the panel. 

Panel ID: Enter a unique, non-zero number in this field. The first two 
digits should be 00. Later on, when the panel is upgraded to 
version 5, you must configure the Insight comms task with 
this value. 

Serial Number: Enter the panel serial number (press MENU-2 on any 
terminal). You must enter the number exactly as it appears, 
including leading zeros. 

Add To Site: Shows the site that will contain the newly enrolled panel. 

Encryption Key: Enter the encryption key for this panel (exactly 32 digits). 
Later on, when the panel is upgraded to version 5, you must 
configure the Insight comms task with this value. Leaving this 
field blank is equivalent to selecting all zeros. 

Connection: Specify the connection method you will use to enrol the 
panel. 

• Ethernet→Panel Ethernet UART: you cannot select 
this option when enrolling a version 4 panel. 

• Serial Port→Panel UART: select this option if you are 
using a direct serial connection between Insight 
Server and the panel, or if you are using a serial to 
TCP/IP protocol converter (e.g. Lantronix). 

• PC Modem→Panel External Modem: choose this 
option if you wish to use a modem on the Insight 
Server computer to dial an external modem on the 
panel. 

• PC Modem→Panel Internal Modem: choose this 
option if you wish to use a modem on the Insight 
Server computer to dial an internal modem on the 
panel. 

Settings: Specify any additional connection parameters here. Settings 
such as baud rate must match those of the panel. 

Panel Server: Do not change this setting from ‘LOCAL’. 

Protocol: Set this to PCDirect. Make sure there is a PCDirect comms 
task configured in the panel. 

Installer PIN: The PIN number of User 1 in the panel. 
 

Warning 
Although you can upgrade version 4 panels, you cannot manage them with Insight until they are 
upgraded to version 5. See page 5. 
 V 
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Troubleshooting 
If you receive a message to say that the upload failed, review the following checklists. 
 
If you are using the Insight protocol to enrol the panel: 
 

• If you upgraded the panel from version 4: 
o Was your firmware upgrade successful?  (Press MENU-2 on any Elite Terminal, 

and confirm that the version is 5.xx) 
o Did you remember to default the panel? 

• The Insight comms task must be Comms Task 1. 
• Check the configuration of your Insight comms task matches with the Insight software: 

o Panel ID (which must be unique and non-zero) 
o Connection method and parameters (including baud rate etc.) 

• Check you have entered the panel serial number correctly (including leading zeros) 
• If you are using Serial Port → Panel UART, make sure you have specified the correct 

serial port on your PC, and that no other programs are using this port. 
• Make sure you have given Insight the correct protocol information. In particular, check 

that: 
o The protocol is set to ‘Insight’. 

• Make sure the other Insight options are correct (page 65). 
• Try stopping and starting the Insight comms task. 
• Try restarting your computer. 

 
If you are using the PCDirect protocol to enrol the panel: 
 

• Make sure your panel ID is unique. Even though PCDirect doesn’t use it, Insight still 
checks this number because it will be used later on. 

• Make sure you have given Insight the correct protocol information. In particular, check 
that: 

o The protocol is set to ‘PCDirect’. 
o You have entered the correct installer PIN. 

• Check the configuration of your Insight comms task matches with the Insight software: 
o Connection method and parameters (including baud rate etc.) 

• If you are using Serial Port → Panel UART, make sure you have specified the correct 
serial port on your PC, and that no other programs are using this port. 

• Try stopping and starting the PCDirect comms task. 
• Try restarting your computer. 
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Creating Panels From Templates 

You can create a panel from a template. Templates can be 
blank panel configurations from Inner Range, or any panel 
that you’ve exported previously. Once you’ve created the new 
panel you can download it into a physical panel at a later date. 
 
To create a panel from a template: 
 

1. In the Insight Toolbar, decide which site will contain 
the panel. If necessary, create a new master site or 
sub-site. 

2. Right click on the site that will contain the panel, and 
choose “New Panel From Template…” in the menu that appears. 

3. The Create New Panel window appears. Enter the correct information for the panel 
being created. 

4. Click OK. 
 
A progress window appears while the panel is being imported. 

Note 
The new panel will be created with the name, ID and serial number you specify. After creating 
the panel, you must manually set up protocol parameters and connection paths. In the Insight 
Toolbar, right click the new panel and select “Properties…” from the menu that appears, then 
click the Protocol and Ports tabs. 

Tip 
Insight ships with a number of “empty panel” templates, including Standard, Enlarged, Access, 
Access 2, Alarms, Apartments, Extra Door and Special. You can use these templates as a basis 
for panel programming without enrolling an empty panel. 

Operator Permissions 
To import a panel, you must have the create permission for panels and the change permission 
on the containing site. The permissions for the new panel are copied from the defaults tab of 
each Operator Type.  
 

Field Descriptions: 
 

File Name: Click the ... button and navigate to the template file you wish 
to import. 

Panel Name: Enter a name for the new panel. 

Panel ID: Enter the panel identification number. This number must 
match the panel ID specified in the Insight comms task. If 
you do not know the panel ID (for example, the panel has not 
yet been delivered), enter any unique number here, and 
change it later on. 

Serial Number: Enter the panel serial number (press MENU-2 on any 
terminal). You must enter the number exactly as it appears, 
including leading zeros. If you do not know the panel serial 
number, enter any number here, then change it later on. 

� 
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Duplicating Panels 

You can duplicate a panel that you have already enrolled, and 
then download the duplicate panel into a physical panel at a 
later date. 
 
To duplicate a panel: 
 

1. In the Insight Toolbar, decide which site will contain 
the duplicate panel. If necessary, create a new master 
site or sub-site. 

2. Hold down the Control key on the keyboard. 
3. Click on the panel you want to duplicate, but do not release the mouse button. 
4. Drag the panel onto the site that will contain the duplicate. A plus sign appears. 
5. Release the mouse button. (You can release the Control key as well.) 
6. The Copy Panel window appears. Enter the correct information for the panel being 

created. 
7. Click OK. 

 
The new panel is created. 

Note 
The new panel will be created with the name, ID and serial number you specify. After creating 
the panel, you must manually set up protocol parameters and connection paths. In the Insight 
Toolbar, right click the new panel and select “Properties…” from the menu that appears, then 
click the Protocol and Ports tabs. 

Operator Permissions 
To duplicate a panel, you must have the create permission for panels, the inspect permission 
on the panel being copied, and the change permission on the site that will contain the copy.  
 

Field Descriptions: 
 

Panel Name: Enter a name for the duplicate panel. 

Panel ID: Enter the panel identification number. This number must 
match the panel ID specified in the Insight comms task. If 
you do not know the panel ID (for example, the panel has not 
yet been delivered), enter any unique number here, and 
change it later on. 

Serial Number: Enter the panel serial number (press MENU-2 on any 
terminal). You must enter the number exactly as it appears, 
including leading zeros. If you do not know the panel serial 
number, enter any number here, then change it later on. 

Moving Panels 

You can move a panel from one site to another site. Note that you can only move panels within 
the same master site. 
 
To move a panel: 
 

1. In the Insight Toolbar, decide which site you want to move the panel to. If necessary, 
create a new sub-site. 

2. Click on the panel you want to move, but do not release the mouse button. 
3. Drag the panel onto the site you want to move it into. A special icon appears. 
4. Release the mouse button. 

 
The panel is moved. 
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Making Connections 

Panel connections are managed from the Insight Toolbar. When a panel is not connected, you 
can do the following: 
 

• Make offline edits to panel programming with Insight Edit, which will be downloaded to 
the panel later. 

• View archived review data with Insight Review 
• Generate reports on archived data with Insight Review (licensed version) 
• Backup your entire Insight database with Insight Archiver 
• Create and manage operators with Insight Operators (licensed version) 

 
When a panel is connected, you can perform the following additional actions: 
 

• Transmit changes to panel programming (including user cards and PINs) 
• Control doors, zone inputs and auxiliaries 
• Read live security logs (review) from the panel 
• Monitor security status with Insight Schematic 

Tip 
A summary of panel connections is shown in the status bar at the bottom right of most Insight 
modules. If no panels are connected, a blinking red square is shown. 
Yellow means some panels are connected, and green means all panels are connected. 
 

Understanding Connection Status 
The status of the panel is displayed graphically in the Insight Toolbar. Refer to the following 
table: 
 
Icon Path Status Description 

 TCP/IP 
 Serial 
 Ext. modem 
 Int. modem 

Disconnected 
The panel is not connected. Programming changes 
will be queued. Review and status information is not 
available. Hardware cannot be controlled. 

 TCP/IP 
 Serial 
 Ext. modem 
 Int. modem 

Connected 

The panel is connected. Live and queued 
programming changes will be transmitted. Review 
and status information is available. Hardware can be 
controlled. 

 TCP/IP 
 Serial 
 Ext. modem 
 Int. modem 

Connection 
error 

The connection could not be established, or has 
been lost. Try ‘troubleshooting’ on page 20. 

Tip 
Connections can take up to twenty seconds to establish. While Insight is negotiating the 
connection, the panel icon changes to . 
 

Tip 
To get a quick overview of the status of all panels in an installation, click the status tab of the 
Insight Toolbar. It lists all panels in a flat hierarchy, with all sub-sites removed from the tree. 
 
 

. 

� 
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To connect a panel: 
 

1. Right-click the panel in the Insight Toolbar, and choose “Auto 
Connect” in the menu that appears. 

 
Insight establishes a connection with the panel. The connection icon 
turns green with a tick upon success, or red with a cross if the 
connection could not be established. 
 

Note 
The connection will remain active, even if you close all Insight modules. The connection will only 
be broken if you choose to disconnect, or if the Insight Server is stopped. 
 

Note 
When you connect a panel, the following operations are performed automatically: refresh LAN 
status (page 29), check for terminal edits, check memory configuration (page 36), download 
review (page 40). 

Tip 
If the panel is configured with multiple connection types (for example, direct serial and dial-up), 
Insight tries the ‘best’ path first. Insight always tries to connect in this order: TCP/IP, direct 
serial, dial-up to external panel modem, dial-up to internal panel modem, GSM. Only configured 
paths are tried – see page25. 

Tip 
If you don’t want to use “auto connect” you can manually specify a connection method. After 
right-clicking the panel, choose “connect” in the menu that appears, then specify the connection 
method to try. If a method is disabled it has not been configured yet for that panel. 

Tip 
You can get more information about the current connection status of a panel. Right click the 
panel and choose “properties” in the menu that appears, then click the “status” icon. 
 

Operator Permissions 
To connect to a panel, you must have the control permission for the panel.  
 

To disconnect a panel: 
 

1. Right-click the panel in the Insight Toolbar, and choose “Disconnect”. 

Operator Permissions 
To disconnect a panel, you must have the control permission for the panel.  
 
 

� 
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Panel Properties 

You can find out further information about 
your panel by opening the panel properties 
window. From here you can rename the 
panel, change Insight protocol settings, 
configure communications ports, set the 
panel date and time, perform directory 
maintenance and inspect other panel 
properties such as firmware version and 
PCB revision. 

To open panel properties: 
 

1. Right-click the panel in the Insight 
Toolbar, and choose “Properties…” in the window that appears. 

To change protocol settings: 
 

1. Open panel properties and click the “Protocol” icon. 
2. Fields marked with a Control Module icon must match the corresponding settings in the 

Insight comms task. 
3. Click OK. 

Tip 
You can configure Insight to connect panels automatically under certain conditions. Open panel 
properties, click the “Protocol” icon then click the Connection tab. 
 

To change port settings: 
 

1. Open panel properties and click the “Ports” icon. 
2. Fields marked with a Control Module icon must match the corresponding settings in the 

Insight comms task. 
3. Click OK. 

Tip 
You can configure multiple paths (such as direct serial and dial-up) so that if one path fails, 
additional paths can be tried. 
 

To set the panel date and time: 
 

1. Open panel properties and click the “Maintenance” icon. 
2. Click the Date/Time button. 
3. To synchronise the panel time with the time on the workstation you are using, click the 

“PC Time” button. To set the date and time manually, highlight each digit and click the 
up and down buttons. 

4. Click OK. 

Note 
The panel must be connected before you can set the date or time. If the panel is not connected, 
the button is disabled. 
 

Warning 
Changing the panel date and time causes all time zones, diaries and holidays to be re-
evaluated, which in turn could alter the state of auxiliaries, calculated auxiliaries and other 
system entities.  

� 
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Remote Control 

You can control your Inner Range security system 
remotely using Insight. You can control areas, area lists, 
auxiliaries, auxiliary lists, doors, door lists, floors, floor 
lists, home auxiliaries and inputs. 

To control items remotely: 
 

1. Click the Control tab of the Insight Toolbar. 
2. Click the item type you want to control 
3. A window appears containing the items of that 

type, and after a moment the current state is 
displayed. 

4. Highlight the item(s) you want to control. 
5. Click the appropriate control button to control the item. 

Tip 
You can select multiple items by holding down the SHIFT or CONTROL keys whilst clicking. 
 
 

Tip 
If an item changes state, the change will be reflected in the control window within five seconds. 
 
 

Tip 
The Insight Toolbar doesn’t have a Control tab in Insight Schematic. To control items in 
Schematic, right click the item directly on the map and choose from the menu that appears. 
 

Operator Permissions 
To control an item you must have the control permission for that item.  
 
 

� 
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Insight Edit 

Insight Edit lets you inspect and modify the programming of your Inner Range security system. 
This includes initial configuration of all security parameters during site commissioning, 
inspection and modification of programming as time progresses and ongoing site management 
functions such as allocating user cards and PINs. 
 
Use Insight Edit to: 
 

• Inspect panel programming 
• Program panels and modules 
• Manage user cards and PINs 

 

   
 
 
 
 
 
 

• The Insight Toolbar lets you manage your sites and panels (page 13). 
• The browse pane displays items you can program (page 28). 

 

Note 
The following sections deal with panel programming. You can only program panels that have 
been enrolled into Insight. To learn how to enrol panels, see ‘enrolling panels’ on page 17. 
 

� 

Insight Toolbar 

Double-Click 
To Edit 

Text Filter

 = installed  
 = missing 
 = unexpected 
 = not installed

Status Filters

Browse Pane

 = upload marker  
 = download marker

Browse Toolbar
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Using the Browser 

The most important part of Insight Edit is the browser pane. Once you have mastered the use of 
this pane you can quickly and easily make programming changes to your panels. 
 
 

 

 

Navigation 
The browser pane is driven from the Insight Toolbar. To program a particular item: 
 

1. In the Insight Toolbar, click the browse tab. 
2. Expand the tree for the panel you wish to program. 
3. Click on the programming item you want. 

Tip 
You can change the layout of the Insight Toolbar by selecting “Preferences…” on the Edit menu, 
then clicking the Interface tab. Installers who are used to the terminal menus will probably want 
to use the “installer” layout. 

Tip 
By default, the browser pane is set to large icon view (pictured). You can 
select different views with the Browse Toolbar. In particular, ‘detail’ view 
allows you to sort the information by clicking on the column headings. 

� 
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 = installed  
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 = unexpected 
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Understanding Item Status 

Various graphics and symbols are used in the browser to reflect the status of each programming 
item. 
 
 
Symbol Applies To Meaning Description 

 
All items Programmed Items that are ‘solid’ have been programmed. 

 
All items Blank Items that are translucent are blank / have not 

been programmed. 

 
All items Upload 

This item has been marked for upload. The next 
time the panel is connected, the item will be read 
from the panel. 

 
All items Download 

This item has been queued for download. The 
next time the panel is connected, the item will be 
written to the panel. 

 
Hardware items Secured The module is present on the LAN and secured. 

 
Hardware items Unexpected The module is present on the LAN, but not 

secured. 

 
Hardware items Missing The module should be on the LAN but isn’t. 

 
Hardware items Uninstalled The module isn’t on the LAN. 

 
All items Shadow 

This record has been created because the panel 
memory configuration has changed, and there are 
more items of this type than before. 

 
All items Surplus 

The panel memory configuration has changed, 
and this record no longer fits into the new 
configuration.  

Tip 
The status of hardware modules (secured, missing etc.) is updated each time you connect with 
a panel. You can also update this status manually. Right-click the panel in the Insight Toolbar 
and choose “Entire Panel” in the menu that appears, then choose “refresh LAN status”. 
 

� 
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Using Filters 

You can filter the browser so that only key items are displayed. There are a number of different 
filtering methods available. 

Using Filter Buttons 
You can quickly show and hide items with the filter buttons. 
 

 Click show programmed to hide or show programmed items 
 Click show blank to hide or show blank / unprogrammed items 

 
 Click show normal to hide or show records that aren’t surplus, shadow or marked 
 Click show upload to hide or show items marked for upload from the panel 
 Click show download to hide or show items marked for download to the panel 
 Click show surplus to hide or show surplus records 
 Click not shadow to hide or show shadow records 

 
 Click installed to hide or show secured hardware 
 Click missing to hide or show missing hardware 
 Click unexpected to hide or show unexpected hardware 
 Click not installed to hide or show uninstalled hardware 

 
To use the filter buttons: 
 

1. Click the appropriate filter button. If the button is active (pressed in), then items 
matching that type will be displayed. 

Note 
Filters are saved for each different item type, even when you exit Insight Edit. Always check the 
item count (bottom right corner) to see if there are any items hidden in the current view. 
 

Using Filter Text 
You can filter based on text that you specify. Text filtering can be applied to the name, address 
or notes field of regular items, and also the site code and user type of users. 
 
To use filter text: 
 

1. Select the field you want to filter on. “Name in panel” is the short name of the item. 
“Name” is the full-length Insight name. “Address” is the notated address (such as DL015 
for door list 15). ‘Notes’ is the notes field kept by Insight for each item. 

2. Enter the text you want to filter by. 
3. Press enter. Your filter is applied. 

Using Wildcards 
You can use special symbols called “wild cards” in your text filters.  The ? symbol matches one 
letter.  The * symbol matches any number of letters. 
 
Here are some example filters to get you started. 
 
� Name = “PIR” → only show items whose name includes the word “PIR” 
� Notes = “delay” → only show items whose notes includes the word “delay” 
� Address = “C01” → only show control module items 
� Address = “T03:Z05” → show the fifth zone input on the third LCD module 
� Address = “T03:Z*” → show all zone inputs on the third LCD module 
� Address = “T*:Z*” → show all zone inputs on all LCD modules 
� Address = “*:Z*” → show all zone inputs on all modules 

� 
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� Address = “?01:Z10” → show the tenth zone input on the first module of each type 
� Address = “*:S?5” → shows all system inputs ending in “5” on every module 
� Name = “k*” → shows all names starting with the letter K 
� Name = “*s” → shows all names ending in the letter S 
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Editing Items 

To edit an item, double click the item in the browser. This opens an edit window for that item. 
 
 

 

 

Using the Navigation Toolbar 
 

 Locate this item in the Insight Toolbar tree. 

 Go to the first record. 

 Go to the previous record. 

 Displays the current record number. You can enter a different number to jump to that 
number. 

 Displays the current record name. Click on the arrow to select a different record to 
jump to. 

 Go to the next record. 

 Go to the next blank / unprogrammed record. 

 Go to the last record. 

Using the Edit Toolbar 
 

 Save changes to the current record. If the panel is offline, mark the record for 
download the next time a connection is available. 

 Turn autosave on or off. With autosave enabled, changes to a record are saved 
automatically as soon as the record is closed or you use the navigation buttons. 

 Discard changes you’ve made to this record without saving them. The record reverts 
to the last saved version. 

 Erase the programming of this record. The record becomes blank / unprogrammed. 

 Upload the current record from the panel. If the panel isn’t connected, the record is 
marked for upload the next time a connection is available. 

 Places the current record into the Windows clipboard. When you select paste, the 
record is then erased. 

Hyperlink 

Navigation 
Toolbar

Edit Toolbar

Name Lock 
Slider 

Tabs

Item Pickers
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 Copies the current record into the Windows clipboard. 

 Pastes from the Windows clipboard over the current record. 

 Undo the last action. You can repeat this command to undo all changes made since 
the record was opened. 

 Opens the find window. 

 Opens the cross-reference window for this item. 

 Opens context-sensitive help for this item. 

Tip 
If you are editing a lot of records, you should probably turn autosave on. As you finish each 
record, using the navigation buttons save your changes automatically. 
 

Operator Permissions 
To open an item, you must have the inspect permission for the item. To save changes to an 
item, you must have the change permission for the item. 
 

Online and Offline Edit 

If you save programming changes while the panel is connected, the changes are sent to the 
panel immediately. This is called “online edit”. If you make changes while the panel is 
disconnected, then the changes are queued to be written later on. This is called “offline edit”. 
 
Insight uses different colours so you can quickly see if there are edits waiting to be sent to the 
panel. 
 
Icon Meaning Description 

 Panel synchronised There are no edits waiting to be sent to the panel. 
 Panel synchronising Programming changes are being exchanged with the panel. 

The number in brackets next to the panel name indicates how 
many changes are remaining to be sent / received. 

 Panel unsynchronised Offline edits have been made. There are programming 
changes waiting to be written to the panel. 

Tip 
If your panel is red (unsynchronised), you can find all records that are queued for upload or 
download by opening a new search, clicking the “only match records marked for upload or 
download” and clicking “Find Now” (without entering any search text). 

More Editing Features 

Long Name and Notes 
Insight lets you enter long names for all items, and a notes field for recording miscellaneous 
details. 

Name Lock Slider 
Although Insight allows for long names on all items, the Control Module only has limited space 
for names. To spare operators from the chore of entering both long and short names, Insight 
automatically links them together. If the name is too long to fit into the panel, a tilde (~) symbol 
is used. 
 

 Names are locked (default behaviour). 

 Names are unlocked and may be edited separately. 
 

� 
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Tip 
If you enter a very long name with numbers at the end, Insight will preserve the numbers and 
remove excess characters from the middle of the name instead of the end. 
 

Item Picker 
Wherever you see a button like this (      ) you can click it to open the item picker. This is a 
window that lets you choose from a list of items. 

Quick Navigation (Hyperlinks) 
Hyperlinks let you quickly navigate between related items, without using the Insight Toolbar to 
manually locate them. To follow a hyperlink, click on it with the mouse button. 
 

 
 

Tip 
You can click as many nested hyperlinks as you like. When you close the windows that have 
popped up, you will return to the original record you were editing. 

 

Previous Software 
In WinDirect, quick navigation was performed with the F9 and F10 keys. On panel terminals, 
quick navigation is performed with the HELP-9 / HELP-0 key combinations. 
 

Searching Panels 

Insight Edit includes an extremely fast search 
tool. You can choose between simple 
searches, which look for matching text in the 
locations that you specify, and advanced 
searches, which let you specify complicated 
searches such as “find everything with the 
word door but not the word office”. 

To perform a simple search: 
 

1. On the Edit menu, choose “Power 
Search…” (or press CTRL+F). 

2. Enter the text you wish to search for. 
3. Choose which panels and item types you wish to search by clicking the “Look In” field 

(optional). 
4. Clear match case if you want GREEN to match with Green. 
5. Clear whole words if you want am to match with hammer. 
6. Enter any settings you want on the “Modified” tab (optional). 
7. Click “Find Now”, or press ENTER. 

 
Items matching the search text are displayed. 

Note 
In simple searches, the ‘name’, ‘name in panel’ and ‘notes’ fields are searched. 
 
 

Tip 
If your panel is red (unsynchronised), you can find all records that are queued for upload or 
download by opening a new search, clicking the “only match records marked for upload or 

� 
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download” and clicking “Find Now” (without entering any search text). 
 

Tip 
You can open any matching item by double-clicking it with the mouse. 
 
 
 

To perform an advanced search: 
 

1. On the Edit menu, choose “Power Search…” (or press CTRL+F). 
2. Click the “Advanced” tab. 
3. Enter your search criterion (see below). 
4. Choose the fields you wish to search (optional). 
5. Enter any settings you want on the “Modified” tab (optional). 
6. Click “Find Now”, or press ENTER. 

 
You specify advanced criteria by entering text (enclosed in single or double quotes) separated 
by special commands and, or, not and xor (“exclusive or”). Placing a text item in double 
quotes means the text will match both upper and lower case. Placing a text item in single 
quotes means the text will only match if the case is the same. Brackets are used like they are in 
arithmetic. 

Examples 
“door” 
 → matches all items with door (including trapdoor, doorstop, DOORMOUSE etc.) 
 
‘DOOR’ 
 → matches all items with DOOR (including TRAPDOOR but not trapdoor) 
 
exact(“door”) 
 → matches all items with the whole word door (including DOOR but not trapdoor) 
 
exact(‘door’) 
 → matches all items with the whole word door (but not DOOR or trapdoor) 
 
“door” or “window” 

 → matches all items with either door or window or both, regardless of capitalisation 
 
“door” and “window” 

 → matches all items with both door and window 
 
“door” and not “window” 

 → matches all items with door, unless the item also has window 
 
“door” or not “window” 

 → matches all items with door, and also matches all items without the word window 
 
not “door” 

 → matches anything that doesn’t have the word door 
 
“exit” and (“door” or “window”  or “corridor”) 

 → matches anything that has either door, window or corridor so long as it also has the 
word exit 

 
“exit” or (“door” and “window”  and “corridor”) 

 → matches anything that has both door, window and corridor or it has exit 
 

“door” xor “window” 

� 
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 → matches everything with either door or window, but not both 

Tip 
If you have difficulty understanding advanced searches, try entering some of the examples 
listed above, then modifying them to what you want. 
 

Operator Permissions 
You must have the see permission on an item for it to appear in the output window. 
 
 

Cross-Referencing Items 

The cross-reference window is a very useful and powerful 
tool for trouble-shooting an Inner Range installation. When 
an item is cross-referenced, all programming relationships 
between that item and the rest of the system are 
displayed. For example, cross-referencing a calculated 
auxiliary show any auxiliaries, inputs, areas, lift cars, floor 
lists and counters that might be influenced by the 
calculated auxiliary. 
 
To cross-reference an item: 
 

1. Select the item in the browser window, or open 
the item for editing. 

2. From the Edit menu, choose “cross-reference”; or 
press F2; or click the “x-ref” toolbar button (editing 
window only). 

 
The cross-reference window appears.  
 
� Any items that this item refers to are shown in the refers to section. 
� If this item appears in the programming of a completely different item, then this 

relationship is shown in the referred from section. 

Tip 
You can open an item from the cross-reference window by right-clicking and choosing “Edit” in 
the menu that appears. 
 

Warning 
The cross-reference window will not show an item if you do not have the see permission for that 
item. In this case, the cross-reference tree will be incomplete. 
 

Panel Memory Configurations 

Each Inner Range panel has a database for storing users and programming information. The 
size of the database is determined by the size of the memory chip on the panel (32, 128 or 512 
kilobytes). For each memory size, there are a number of memory configurations (such as 
Standard, Alarms and Special) that determines how many items of each type are stored by the 
panel. This count of items is known as the directory of the panel. For example, the 512k 
Standard directory has 128 doors, 250 areas, 64 time zones and so on. 
 
When you connect to a panel, Insight automatically checks the panel’s directory. Under normal 
circumstances, the directory of the panel and the directory stored by Insight is the same. Under 
certain circumstances, they can be different. 
 

1. You have used a terminal to ‘default’ (change) the panel configuration since it was 

� 
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enrolled; or 
2. You created the panel in Insight from a template or by duplicating another panel, and 

are now connecting to a panel with a different memory configuration. 
 
Both situations cause a conflict in Insight, because the panel contains a different number of 
records than you can see in Insight. Insight automatically resolves the conflict by creating 
surplus and shadow items.  
 
Surplus items are records that no longer fit in the new panel memory configuration. You can 
edit them, but they cannot be saved to the panel unless the panel configuration is changed to 
something else. If you know you will never do this, then the surplus records can be trimmed, 
which deletes them permanently from Insight. 
 
Shadow items are records that exist in the new panel configuration, but not in Insight. They are 
like a ‘place holder’, telling you that the records exist in the panel but have not been uploaded 
yet. If you know you will be sticking with the new memory configuration, then these records 
should be expanded, which converts them into ‘real’ records by uploading them from the panel. 
 
Below are some examples of surplus and shadow records and how they are created. 

Example 1 
 

Insight: 
    

4 diaries 

Panel: 
  

2 diaries 

Insight after connect: 
    

4 diaries (2 normal, 2 surplus) 

Insight after ‘trim’ command: 
 

2 diaries 

Note 
If you edit a surplus record and click save, your panel will be permanently unsynchronised 
(since Insight can never save your changes to the panel). To rectify this, you should trim the 
surplus records. 

Example 2 

Insight: 
 

1 door 

Panel: 
    

4 doors 

Insight after connect: 
    

4 doors (1 normal, 3 shadow) 

Insight after ‘expand’ command: 
    

4 doors 

Tip 
If you make changes to a shadow record, it is automatically converted to a normal item and 
queued for download to the panel.  
 

� 
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Trimming and Expanding Records 
Under normal circumstances, you should always trim (delete) surplus records, and expand 
(upload) shadow records. Insight doesn’t do this automatically, because you might want to copy 
the information out of surplus records before trimming, and because expanding shadow records 
can be time consuming (they have to be uploaded into Insight).  
 
To trim or expand records: 
 

1. Right click on the panel in the 
Insight Toolbar, and choose 
“Properties…” from the menu that 
appears. 

2. Click the “Maintenance” icon. 
3. Click the “Directory” tab. 
4. Click “Compare”. The panel column 

shows how many items are in the 
current panel memory configuration. 
The Insight column shows how 
many items are being displayed by 
Insight. 

5. Select the items you want to expand or trim, or click “select all” to work on the entire 
panel. 

6. Click “Expand Insight” to convert shadow records into normal records. If you are 
connected to the panel, the records are uploaded immediately; otherwise, they are 
queued for upload the next time it is connected. Click “Trim Insight” to delete surplus 
records from Insight. Click “Expand+Trim” to automatically expand or trim, depending 
on which operation is appropriate. 

 

Warning 
You cannot undo the trim command - the surplus records are permanently deleted. 
 
 

Note 
Trimming and expanding has no effect at all on the panel. It only effects surplus and shadow 
records Insight. 
 

Note 
You cannot change the panel memory configuration with Insight. This can only be performed at 
a panel terminal. 
 

Tip 
You can trim or expand a particular item type by right-clicking the item in the Insight Toolbar, 
then choosing “Trim Surplus Records” or “Expand Shadow Records” in the menu that appears. 
 

Tip 
You can quickly trim or expand the entire panel by right-clicking the panel in the Insight Toolbar, 
then choosing “Entire Panel → Trim Surplus Records” or “Entire Panel → Expand Shadow 
Records” in the menu that appears. 

Operator Permissions 
To trim records, you must have the change permission on the containing panel.  
 
 

V 
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Insight Review 

Insight Review lets you search, filter and print security events from your Inner Range security 
system. The Professional Edition also lets you generate and print a range of reports. 
 
Use Insight Review to: 
 

• View live and archived review 
• Search and filter review data 
• Generate reports (professional edition) 

 
 
 
 

 
 
   
 
 
 

• The Insight Toolbar lets you manage your sites and panels (page 13). 
• Review Windows let you search, filter and display review (page 41). 
 

 

Insight 
Toolbar 

Browse 
Toolbar 

Review Windows 

Review Toolbars

Review

Filter 
Stacks
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Underlying Concepts 

Inner Range panels maintain an audit trail of access control and alarm events known as review. 
Depending on the size and configuration of the panel, this can be up to 6500 entries. Once the 
review log is full, it slowly begins overwriting itself. 
 
Insight uploads review from panels whenever it is connected, and stores it in a permanent 
archive. The archive can be examined in real time (as new events are added by panel activity) 
or historically. Because Insight keeps a permanent archive, it does not matter when the panel 
review log overwrites itself. 

Warning 
Insight only receives review from panels while they are connected. If events occur when a panel 
is disconnected, it is queued and received by Insight the next time a connection occurs. The 
number of events that can be queued varies depending on panel size, but is guaranteed to be 
at least 300 events and will be at most 6,500 events. 

Warning 
Insight tracks review via the Insight comms task (menu 7-3-1 at any terminal). If this comms 
task is stopped and started (manually or via the Control Module being reset) then Insight cannot 
determine which review events are ‘unseen’. In this case, you must move the review pointer 
manually. 

Previous Software 
In PCDirect and WinDirect, review was received automatically during online edit mode. Because 
Insight is a multi-panel multi-workstation system, panel connectivity is controlled via the Insight 
Toolbar. 

Tip 
Insight uploads review from panels whenever they are connected, even if the Review module is 
not running. 
 
 

V 

V 
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Review Windows 

Review is examined in a window called the review window. You can have as many review 
windows open at a time as you like, each with its own set of filters. To open a new review 
window, select “New…” from the File menu, or press CTRL+N. 
 
 

 
 
 
 
 
 

Using the Review Toolbar 
 

 Open a new review window. 

 Open a saved filter stack. 

 Save the current filter stack. 

 Show or hide the filter stack. 

 Add a new filter to the filter stack (and stops review processing). 

 Turn auto-scroll on or off. 

 Clear the current window. Disabled if review processing is enabled. 

 Starts and stops review processing for this window. 

Using the Filter Toolbar 
 

 Open a saved filter. 

 Save the filter for use later. 

 Remove the filter from the filter stack. 

 Toggle and/or logic. If and is selected, review must match this filter as well as 
previous filters. If or is selected, review only has to match this filter plus any 
subsequent and filters. 

Review

Period Filter 

Thing Filter 

Review Toolbar

Filter Stack 

Filter Toolbar 
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To Examine Review: 
 

1. Open a new review window (CTRL+N) 
2. Load or modify the filter stack to suit your requirements 
3. If your filter stack includes the “all review”, “live review” or “last…” filters, and you want 

review to appear as it happens at the panel, make sure the panel is connected in the 
Insight Toolbar. 

4. Click the “GO” button. 

Filtering Review 

Since Insight saves every single review event ever received, the number of events can grow to 
a large number. Usually, you will only be interested in examining review from a particular time 
period or from a specific panel. You can quickly isolate review of interest by applying filters. 

About Filter Stacks 
Each review window has a filter stack applied to it. A filter stack is a collection of one or more 
filters which are “stacked” between the window title and the window contents. When you modify 
the filter stack, you change what review events are displayed in the window. 

Tip 
You can hide the filter stack by clicking the show/hide filter stack button. The filters still apply 
even when hidden. 
 

Time Filters 
Time filters let you filter for review that occurred at a certain time. There are five types of time 
filters. 
 

On: Lets you specify a particular day. You can also specify a time interval on 
the specified day, for example 18:30 to 19:15. 

From / To: Lets you specify an interval that spans more than one day. For example, 
midday on March 15 until 8pm on April 3rd. 

Last: Lets you specify review that occurred within a certain range of the current 
time. For example, the last 45 minutes or the last 2 weeks. As time passes, 
entries will disappear with this filter type. 

Live Review: This special filter type matches any review that is received live from a 
connected panel. 

All Review: This special filter type matches ALL review unconditionally, including live 
review from connected panels. 

Thing Filters 
Thing filters let you filter for review that concerns a particular item. There are three types of thing 
filter. 
 

Panel: Lets you select a specific panel. 

XMIT Alarms: Only matches the class of events known as XMIT entries. Generally, these 
are alarms. 

Text Compare: Lets you specify any text string. The string is compared with each review 
entry. 

Paid Feature 
You cannot create XMIT alarm filters in Insight Lite. 
 

� 
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To add a filter to the filter stack: 
 

1. Click the add filters button in the toolbar ( ) and choose the appropriate type. 
2. Modify the filter according to you requirements. 
3. If this isn’t the only filter in the stack, click the and/or button to determine how this filter 

interacts with the other filters in the stack. 

4. Click the go button ( ) to activate review processing for the window. 

Tip 
You can search for items in the review window. Choose “Find…” from the Edit menu, or press 
CTRL+F. 
 

Tip 
You can copy items in the review window into the Windows clipboard. Select the item(s) you 
want to copy, then choose “Copy” from the Edit menu, or press CTRL+C. You can select 
multiple rows by holding down the Shift or Control keys whilst clicking in the review window. 

Tip 
You can save review to a text file. Choose “Save As…” from the File menu, or press CTRL+S. 
 
 

Alarms 

You can configure review to play a sound when an alarm or 
restore occurs.  

To play a sound when an alarm occurs: 
 

1. Choose “Preferences…” from the Edit menu. 
2. If you want the PC’s internal speaker to beep, tick 

the “beep the PC’s internal speaker” checkbox. 
3. Select the sound you want played when an alarm is 

received. 
4. Decide if you want a different sound to play when 

the alarm is restored, and fill in the appropriate 
settings. 

5. Click OK. 
 

Tip 
If you do not like the preset sounds you can choose a custom sound, which can be any file in 
WAV format. 
 

Note 
Custom sounds are not backed up by Insight Archiver. If you delete or rename the custom 
sounds, then they will not be played by Insight. 
 

Tip 
You can configure a review window so that it only displays alarm events. See page 42. 
 
 

Paid Feature 
You cannot play alarm sounds in Insight Lite. 

� 
� 
� 
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Moving The Review Pointer 

If the Insight comms task is reset, then Insight cannot determine which review entries have not 
been processed. In this case, it is possible to move the review pointer manually. 

To move the review pointer: 
 

1. Right click the panel in the Insight Toolbar and choose “Review” in the menu that 
appears, then choose “Move Back…”. 

2. Enter how far back you want to move the review pointer. 
3. Click Close. 

Warning 
Moving the review pointer may cause duplicate review entries to be recorded. This feature is 
recommended for experts only. 
 
 

Reports 

You can generate a range of reports in Insight Professional. 
 
To generate reports: 
 

1. Select the desired report from the Reports menu. 
2. Specify the criteria for your report. 
3. Click OK. Insight generates the report. 

 
 

Paid Feature 
The Time On Site report is not available in the standard version of Insight Professional. It must 
be activated with an additional Licence Key. 
 

Tip 
You can print the report. Choose “Print…” from the Edit menu. If your report doesn’t paginate 
correctly, then regenerate the report and change the “records per page” value to something 
else. 

Tip 
You can search for items in the report. Choose “Find…” from the Edit menu, or press CTRL+F. 
 
 

Tip 
You can copy all or part of the report into the Windows clipboard. Select the portion you want to 
copy, then choose “Copy” from the Edit menu, or press CTRL+C. Formatting will be preserved if 
you paste the report into applications that can handle it. 

Tip 
You can save the report to a file. Choose “Save As…” from the File menu, or press CTRL+S. 
The file is saved in HTML format and can be opened by any web browser. 
 
 

V 
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Insight Archiver 

Insight Archiver provides a one-click backup solution for your Insight security database. All 
database components (including review and panel programming) are archived into a single ZIP 
file for convenient storage, with optional encryption. 
 
Use Insight Archiver to: 
 

• Backup your database 
• Restore a previous backup 

 

To create a backup: 
 

1. Ensure the “Backup” radio button is selected. 
2. Specify a location for the backup file to be saved. You can navigate to a different folder 

easily by clicking the ellipsis (…) button. 
3. If you want the archive to be encrypted, tick the “Encrypt” checkbox. 
4. Click Start. If you specified encryption, you will be asked to enter an encryption 

password. 
5. Your Insight database is archived into a single ZIP file that you specified. 

Warning 
Do not forget the encryption password. Your backup cannot be recovered without it. 
 
 

To restore from a backup: 
 

1. Ensure the “Restore” radio button is selected. 
2. Specify the backup file you want to restore from. You can navigate to the folder easily 

by clicking the ellipses (…) button. 
3. Click Start. If the archive is encrypted, you must enter the decryption password. 
4. If Insight Server is running, you will be asked to wait while the Server is stopped. 
5. Your Insight database is replaced with the archive. 

Note 
When you restore from a backup, the current Insight database is moved into another folder - just 
in case. You cannot restore from this “auto backup”, but you can reconstruct your database 
manually in an emergency. 

Note 
Insight Archiver must be run on the Insight Server computer. 
 
 

V 
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Insight Licence Manager 

Insight Professional requires licence keys to function. These licence keys are stored in the USB 
hardware lock that was shipped with Insight Professional. 
 
Use Insight Licence Manager to: 
 

• View installed licence keys 
• Install and remove licence keys 

   
 

 
 
 

• The serial number identifies your Insight installation. 
• The licence keys determine which features of Insight are available. 

 

Paid Feature 
Insight Licence Manager is part of Insight Professional. 
 
 

Registering Insight Professional 

Insight Professional will operate in Professional mode for thirty days from the initial installation 
date. During this time, you must contact Inner Range for a permanent Professional licence key.  

To register Insight Professional: 
 

1. Choose “About…” from the Help menu of any module. 
2. Click the hyperlink that says Click to Register. A new window appears. 
3. Click the hyperlink that says Click here for registration form. 

 

Warning 
If you fail to register in the 30-day period, Insight will revert to Lite operation. As soon as your 
permanent Professional key is entered, Insight will return to Professional operation. 
 

Tip 
The Insight serial number is etched inside the hardware key. You can 
quickly check the serial number by opening the About box in any module.  

 

V 
� 
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Insight Operators 

Insight Operators lets you manage who is allowed to login to Insight, and what privileges they 
have within the Insight system. 
 
Use Insight Operators to: 
 

• Create operators 
• Delete operators 
• Modify operator privileges 
• Create “locked down” workstations with reduced privileges 

 
 

   
 
 
 
 
 
 

• The Insight Toolbar lets you select between operators, workstations and operator 
types. 

• The browse pane displays items you can modify. 
 

Paid Feature 
Insight Operators is part of Insight Professional. Operator passwords are bypassed in the 
demonstration version of Insight. 
 

Demo Edition 
Operator passwords are bypassed in the demonstration version of Insight. 
 

 

 
 

Insight Toolbar 

Browse Toolbar

Launch Toolbar

Browse Pane
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Working With Operators 

Access to Insight modules is restricted to 
authorised personnel called operators. 
Operators have their own user name and 
password. Operators can be assigned different 
levels of privilege, which determine what 
operations they can perform. 
 
Special operators can be created called 
administrators. Administrators are like normal 
operators, but with permanently elevated 
privileges. 

To create an Operator: 
 

1. Click the Operators tab in the Insight Toolbar. 
2. Click the “New” button; or press the Insert key; or right click the browser pane and 

select “New Operator…” from the menu that appears. 
3. Enter a unique name for the Operator. 
4. Specify a password for the Operator. 
5. Click the “Types” icon, and allocate Operator Types to the Operator. 
6. Click OK to save the new Operator. 

 

To delete an Operator: 
 

1. Click the Operators tab in the Insight Toolbar. 
2. Right click the Operator and choose “Delete” in the menu that appears; or click the 

Operator with the left mouse button, then press the Delete key. 
3. Click Yes when asked if you really want to delete the Operator. 

Tip 
You cannot delete yourself. 
 
 

Operator Permissions 
To create an Operator you need create permissions on operators. To delete an operator you 
need delete permission on the operator. 
 

To suspend an Operator: 
You can suspend an operator without deleting them. 
 

1. Open the Operator you wish to suspend. 
2. Click the “Disabled” radio button. 
3. Click OK. The Operator will not be able to login to any modules. 

Tip 
You cannot suspend yourself. 
 
 

Operator Permissions 
To suspend an Operator you must have the change permission on the Operator. 

� 
; 

� 
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Working With Operator Types 

Operator Types let you control which 
items Operators can see, create, 
delete, control and modify. 
 
Once an Operator Type has been 
created, you can assign it to Operators. 
 
 
 
 
 

To create an Operator Type: 
 

1. Click the Operator Types tab in the Insight Toolbar. 
2. Click the “New” button; or press the Insert key; or right click the browser pane and 

select “New Operator Type…” from the menu that appears. 
3. Enter a unique name for the Operator Type. 
4. Click the “Permissions” icon, and allocate privileges to the Operator Type. 
5. Click the “Log On” icon, and specify which workstations Operators of this type are 

permitted to log on from. 
6. Click OK to save the new Operator Type. 

To delete an Operator Type: 
 

1. Click the Operator Types tab in the Insight Toolbar. 
2. Right click the Operator Type and choose “Delete” in the menu that appears; or click the 

Operator Type with the left mouse button, then press the Delete key. 
3. Click Yes when asked if you really want to delete the Operator Type. 

Note 
Deleting an Operator Type might prevent Operators from logging in, since an Operator with no 
Type cannot login to Insight modules. 
 

Tip 
Operators who are Administrators automatically receive all privileges. You do not have to assign 
them any Operator Types. 
 

Operator Permissions 
To create a new Operator Type, you must have the create permission for Operator Types. To 
delete an Operator Type you must have the delete permission on the Operator Type. 

� 
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Working With Permissions 

Permissions are at the heart of Operator Types. 
With permissions, you can precisely control what 
an Operator can do in Insight. 
 
There are three pages of permissions in each 
Operator Type: sites and panels shows 
permissions for all sites, panels, panel 
programming and maps. Security shows 
permissions for Operators, Operator Types and 
Workstations (in other words, the items 
manipulated by the Insight Operators module 
itself). Defaults shows what permissions will apply to new items that are created in the future. 
 
Insight lets you define what an Operator can do via nine permissions. 
 
Permission Description 
See The see permission means you can see the item in lists and browser panes. 

Inspect 
The inspect permission means you can open the item and see how it is 
configured. 

Change 
The change permission means you can modify the item and save your 
changes. 

Create 
The create permission means you can create new items of that type. Note that 
permissions on the new item will be copied from the Defaults page. 

Delete 
The delete permission means you can delete the item. For panel items like 
doors and user types, this permission lets you reset the record to the 
unprogrammed state. 

Control The control permission means you can control the item via the Insight Toolbar. 
Print The print permission is not currently implemented. 
Export The export permission is not currently implemented. 
Set Perms The set perms permission is not currently implemented. 
 

Setting Permissions 
You grant or deny permissions on a particular item by ticking or clearing the corresponding 
checkbox for that item. 
 
The privileges windows are deliberately organised in a tree structure. When you tick an item at 
the top of the tree, the tick “ripples” down through the branches of the tree. Thus, ticking “see” at 
the top-most site level grants the “see” privilege to all items in the site including sub-sites, 
panels, programming items and maps. 

Tip 
If you don’t want a tick to “ripple” down the tree, hold down the Control key when you click the 
checkbox. The tick will not ripple more than one level down. 
 

Tip 
Sometimes, you may want to “ripple” a setting that only makes sense at the lower branches of 
the permission tree. For example, you can control doors but not sites. In this case, Insight 
provides a “ripple only” check box with a black border. The only purpose of this check box is to 
provide a convenient means of turning the permission on and off at a high level in the tree. 
 

� 
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Operator Permissions 
To set permissions on an item, you must have the set perms permission on that item. To set 
some items, you must also be an administrator. 
 
 

Working With Workstations 

Insight lets you use workstations in two ways. 
 

1. You can specify that certain Operator 
Types must log on from designated 
workstations. 

2. By applying an Operator Type to a 
workstation, you can limit the 
permissions that are available from 
that workstation. 

To create a workstation: 
 

1. Click the workstation tab in the Insight 
Toolbar. 

2. Click the “New” button; or press the Insert key; or right click the browser pane and 
select “New Workstation…” from the menu that appears. 

3. Enter the name of the workstation, or click the Browse button and select the 
workstation from the network. 

4. Click OK to save the new workstation. 
 

To delete a workstation: 
 

1. Click the workstation tab in the Insight Toolbar. 
2. Right click the workstation and choose “Delete” in the menu that appears; or click the 

workstation with the left mouse button, then press the Delete key. 
3. Click Yes when asked if you really want to delete the workstation. 

To create a “locked down” workstation: 
 

1. Create an Operator Type, and set up the maximum permissions that will be permitted 
from your locked-down workstation. 

2. Right-click the workstation and choose “Properties…” from the menu that appears. 
3. Click the “Operator Type” icon. 
4. Click the radio button labelled “Restrict permissions to this operator type”. 
5. Select the Operator Type you created. 
6. Click OK to save your changes. 

 
Any permission that isn’t granted in the Operator Type will never be allowed on the locked-
down workstation. Any permission that is granted in the Operator Type may be allowed on the 
locked-down workstation, depending on the Operator’s normal permissions. 

Note 
You cannot create or edit Operator Types from workstations that have been locked down. 
 
 

Warning 
It is possible to lock yourself out of Insight completely with this feature. Use it carefully, and 
make sure you never lock down your system in such a way that you (the administrator) cannot 
change permissions from any workstation. 
 

; 
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Operator Permissions 
To create a new workstation, you must have the create permission for workstations. To delete a 
workstation, you must have the delete permission for that workstation. 
 

 

; 
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Insight Schematic 

Insight Schematic allows operators to monitor the status of an installation via an intuitive 
interface based around graphical floor plans and site maps. Special icons can be placed on 
each map that show the status of hardware items (such as inputs, areas and auxiliaries) in real 
time. 
 
Use Insight Schematic to: 
 

• Import site plans 
• Browse drill-downs 
• Add areas, auxiliaries, inputs, doors, lifts and modules to plans 
• Monitor site activity in real time 
• View and acknowledge alarms 
• Control your Inner Range security system 

 
 

   
 
 
 
 
 
 

• The Insight Toolbar lets you manage your sites and panels (page 13). 
• The map lets you add elements to your map, and to monitor these elements in real time 

(page 57). 
 

Insight Toolbar 

Schematic Toolbar

Map Edit Toolbar 

Area

Alarm Group

Zone Area

Map Item (Door) 

Map
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Working With Maps 

To use Insight Schematic, you must first import a map of 
your site or buildings.  

Note 
You cannot create maps with Insight Edit. You must create 
or scan your map with other software, then import the 
image file into Schematic. 

To import a map: 
 

1. In the Insight Toolbar, click on the site that will 
contain the new map. If necessary, create a new 
master site or sub-site. 

2. Choose “Import Graphic…” from the Map menu. 
3. Navigate to the image file you wish to import 
4. Click Open. 

 
The map is added to the selected site.  

Tip 
Several sample maps are installed with Insight. Navigate to the location where you installed 
Insight, then look in the “Sample Maps” directory. 
 

Tip 
You can change the scale of a map that you have imported. Select “Zoom…” from the Map 
menu. 
 

Tip 
Once a graphic is imported, you can delete or move the original file. Schematic stores its own 
copy of the image. 
 

Tip 
Schematic can open files in the following formats: BMP (Bitmap), JPEG (Joint Photographic 
Expert Group), PNG (Portable Network Graphics) and TIF (Tagged Image Format). Pictures in 
other formats (including AutoCAD DWG files) must be converted into one of these formats prior 
to importing. 

Tip 
Once a graphic is imported, you can delete or move the original file. Schematic stores its own 
copy of the image. 
 

To rename a map: 
 

1. In the Insight Toolbar, right-click the map you wish to rename and choose 
“Properties…” in the menu that appears. 

2. Enter the new map name. 
3. Click OK. 

Operator Permissions 
To import a map, you must have the create permission for maps. To delete a map, you must 
have the delete permission for that map. To rename a map, you must have the change 
permission for that map. 

� 
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Working With Surveillance Items 

Surveillance items correspond to hardware detectors and devices in your Inner Range system, 
and fall into one of two categories. 
 
� Point items occupy a single point on the map. These items are usually doors, 

auxiliaries, reed switches and the like. 

� Area items occupy shaped regions on the map. These items are usually Inner Range 
areas, or sensor devices such as motion detectors or perimeter beams. 

 

Adding Surveillance Items 

You can monitor the status of your installation by adding surveillance items to your maps.  

To add point surveillance items: 
 

1. Ensure you are in Edit Mode (select “Edit Mode” from the File menu). 
2. In the Insight Toolbar, expand the Site Tree until you reach the item you wish to 

monitor. 
3. Click the item with the left mouse button, but do no release the button. 
4. With the button held down, drag the item onto your map and release the button. 
5. If necessary, fine-tune the placement of the item. 

To add area surveillance items: 
 

1. Ensure you are in Edit Mode (select “Edit Mode” from the File menu). 
2. If you are placing an area, select the Area tool ( ). If you are placing a zone input, 

select the Zone Area tool ( ). 
3. Draw the area by clicking on the map. Hold the CTRL key down if you wish to draw 

angled lines. 
4. To finish the shape, either double-click the mouse button, or click on the first point of the 

shape. 
6. In the Insight Toolbar, expand the Site Tree until you reach the area or zone input you 

wish to monitor. 
7. Click the item with the left mouse button, but do no release the button. 
8. With the button held down, drag the item onto the shape you just created and release 

the button. 

Tip 
You can place the same item more than once, either on the same map or different maps. 
 
 

Tip 
You can see which items have been placed on maps via the Map Items window. Select “Map 
Items Window” from the View menu. 
 

Tip 
You can jump straight to a placed item on any map. Choose “Go To” from the Edit menu. 
 
 

Tip 
You can choose between two icon sizes. In the Insight Toolbar, right-click the map and choose 
“Properties…” from the menu that appears. Click the Appearance tab, then choose the icon size 
you prefer. 

� 
� 
� 
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Tip 
When an item is placed, a text caption appears under the item. You can change the position of 
the caption, or hide it completely. Right-click the item and choose “Position Caption” from the 
menu that appears. 

Tip 
You can hide captions on all maps, or change their font. Select “Preferences…” from the Edit 
menu, then click the Captions tab. 
 

Tip 
When you place items, they are aligned to a “snap” grid. You can change the size of the snap 
grid - choose “Preferences…” from the Edit menu. You can disable grid snap - uncheck “Snap 
To Grid” in the Edit Menu. You can hide the snap grid - click the “show/hide snap grid” button in 
the Schematic Toolbar. 

Operator Permissions 
To add, move or delete surveillance items from maps, you must have the change permission on 
that map. 
 

Understanding Surveillance Item Status 

Insight conveys the status of surveillance items through the use of colour. 
 
Sample Type Colour Meaning Description 

 
Input Green Sealed The input is in a sealed state. 

 
Input Red Alarm The input is in an alarm state. 

 
Input Orange Tamper The input is in a tamper state. 

 
Auxiliary Blue On The auxiliary is on. 

 
Auxiliary Grey Off The auxiliary is off. 

 
The following symbols may be drawn on top of surveillance items to convey additional 
information. 
 
Sample Type Meaning Description 

 
Input Isolated The input is isolated. 

 
Auxiliary Override The auxiliary is in an override state, and cannot be turned 

on or off until the override is ended. 

 
Auxiliary Not Present The module containing the auxiliary is not present on the 

LAN. 
 

� 
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The status of areas and zone areas is displayed using different colours. 
 

Areas  Zone Areas 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Tip 
By default, Insight uses a slightly translucent colour when drawing shapes. If your computer 
performs sluggishly you can disable this behaviour. From the Edit menu choose 
“Preferences…”, click the General tab, then select the “shapes are solid” radio button. 
 

Adding Labels 

You can add text labels to your maps. To add labels: 
 

1. Ensure you are in Edit Mode (select “Edit Mode” from the File menu). 
2. In the Insight Toolbar, click the map you want to add the Alarm Group to. 
3. Select the Label tool ( ). 
4. Click on the map where you want to place the label. 
5. Enter the text of your label. 

 

Adding Alarm Groups 

Alarm Groups let you monitor alarms from many sources and display them at a single point on 
your map. 
 
To add an Alarm Group to your map: 
 

1. Ensure you are in Edit Mode (select “Edit Mode” from the File menu). 
2. In the Insight Toolbar, click the map you want to add the Alarm Group to. 
3. Select the Alarm Group tool ( ). 
4. Click the map where you want to place the Alarm Group. 
5. In the Alarm Group properties window, enter a name for the Alarm Group. 
6. In the Site Tree, tick the inputs that you want to add to the Alarm Group. 
7. Click OK. 
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Creating Drill-Downs 

With drill downs, you can create maps that link to other maps. For example, a site diagram 
could have clickable buildings that open more detailed interior schematics, or clicking a stairwell 
could jump to the next floor in an office building. You can create drill-downs quickly and easily in 
Insight Schematic. 

To create a drill-down: 
 

1. Ensure you are in Edit Mode (select “Edit Mode” from the File menu). 
2. If you will be drilling to a different map, ensure that the map has already been imported 

into Schematic. 
3. Select the Map Link tool ( ). 
4. Trace the outline of your drill-down by clicking on the map. The shape you draw will be 

the shape that triggers the drill-down. Hold the CTRL key down if you wish to draw 
angled lines. 

5. To finish the shape, either double-click the mouse button, or click on the first point of the 
shape. 

6. Right-click the new shape, and choose “Target…” from the menu that appears. The 
mouse cursor changes to “link”. 

7. If you are drilling to a different map, click the map in the Insight Toolbar. 
8. Click the map where you want to drill to. The cursor changes back to a regular arrow. 

 

Tip 
In Surveillance Mode, you can follow a drill-down by clicking twice. In Edit Mode, you can follow 
a drill-down by right-clicking and choosing “Follow Link” in the menu that appears. 
 

Working In Surveillance Mode 

Insight Schematic starts monitoring the status of all surveillance items when you activate 
Surveillance Mode. 

To activate surveillance mode: 
 

1. Select “Surveillance Mode” from the File menu. 
 
In a few moments, the state of all surveillance items is updated. 
site or buildings.  

Note 
Insight Schematic cannot monitor the status of panels that are not connected. Schematic places 
a cross over all point surveillance items that belong to offline panels, and draws all area 
surveillance items a dim grey colour. 

Alarm Processing 

Schematic has a simple alarm reporting and clearing mechanism. Items that go into an alarm or 
tamper state flash and change colour.  
 
� Point surveillance items go red for alarm and orange for tamper; in addition, the text “in 

alarm” flashes while the alarm is active, and “had alarm” if the alarm condition has 
passed. 

� Area surveillance items go red when in alarm, and orange when in tamper; in addition, 
the flashing speed halves when the alarm condition has passed. 

 

Alarms will continue to flash, even after the condition that caused the alarm ends. You must 
clear alarms from Insight Schematic manually. 

� 

� 
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To clear alarms: 
 

1. Right click the item that is in alarm and choose “Clear” from the menu that appears. 
 
The alarm is cleared. 

Note 
If Schematic is open on more than one workstation then the alarms must be cleared on each 
workstation. 
 

Note 
Clearing alarms in Insight Schematic does not acknowledge the alarms at the panel. You must 
still acknowledge alarms from a Terminal. 
 

Note 
Insight Schematic must be running when Area alarm events occur, or they will not appear in 
Schematic. All other alarm events will be displayed even if they occurred before Insight 
Schematic was opened, provided the alarms are still active. 

� 
� 
� 
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Insight Server Tool 

The Insight Server Tool lets you perform advanced server tasks. 
 
Use the Insight Server Tool to: 
 

• Manually start or stop Insight Server 
• See who is connected to Insight Server 
• Disconnect clients who are connected 

 
 
 
 
 
 

 
 

Starting and Stopping Insight Server 

Insight Server normally starts automatically. Insight Lite starts its own internal server when the 
operator logs on. Insight Professional starts the server as soon as Windows has loaded (but 
before anyone has logged in). 
 

 Insight Server is running and accepting client connections. 
 Insight Server is running, but no connections will be accepted. 
 Insight Server is stopped. The server will start again if an operator tries to log 

on. 

To stop Insight Server: 
 

1. Right click the Insight Server Tool and choose “Stop Database” in the menu that 
appears. 

Note 
Stopping the server can take up to one minute. 
 
 

Warning 
If you stop Insight Server, all operators will be forcibly disconnected. All panels will also be 
disconnected, and review and alarms will not be received until the panels are reconnected. 
 

To start Insight Server: 
 

1. Right-click the Insight Server Tool and choose “Start Database” in the menu that 
appears. 

Note 
Starting the server can take up to one minute. 
 
 

Note 
To start the Insight Professional server, the red lamp must be illuminating on the hardware lock, 
which must be plugged into a USB port on the server computer. 

� 
V 

� 
� 

Insight Server Tool
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Viewing Client Connections 

You can see which operators are connected to 
Insight Server. You can also block connections, 
so operators can no longer log on. 

To view client connections: 
 

1. Right-click the Insight Server Tool, and 
choose “Client Connections…” in the 
menu that appears. 

 

To disconnect an operator: 
 

1. Right-click the Insight Server Tool, and choose “Client Connections…” in the menu that 
appears. 

2. Select the session that you wish to disconnect. 
3. Click Stop. 
4. In the Module Shutdown window, enter a message that will be displayed on the 

Operator’s workstation and also specify how long the message will appear before the 
session is terminated. 

5. Click OK. 
 

To block new connections: 
 

1. Right-click the Insight Server Tool, and choose “Client Connections…” in the menu that 
appears. 

2. Tick the “Block new connections” checkbox. 
 
New connections will not be accepted. Note that sessions that have already been established 
are not affected. 
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Appendix A: Comms Task Configuration 

Insight communicates with panels via an Insight comms task. This comms task must be CT001 
in the panel. 

Insight Comms Task Setup 
 

1. Using an elite terminal, log in with the Installer PIN and go to menu 7-3-1 (comms 
tasks). 

2. If your panel is using factory settings (or the panel has been defaulted) then CT001 will 
be set to Insight. In this case, you will only need to adjust the settings in red. 

3. Press help > 9, and change the panel ID to a unique, non-zero value. The first two digits 
should be 00. The value you enter here must match the number assigned in the Insight 
front-end software (see pages 18 and 25). 

4. Leave all other settings on their defaults, which are listed below: 
 
Panel ID = 00xxxxxx1 (*) 
Port: 1 
Baud: 9600 (*) 
Opts NUIP = ....nnnn 
Ethernet = ....nnnn 
RS232 = ....nACE 
FE3000 = ....nnnn 
Ext. Mod = ....nnnn 
Int. Mod = ....nnnn 
Insight IP: 0.0.0.0 
Insight Key1: 0 
Insight Key2: 0 
IPFast IP: 0.0.0.0 
IPFast Key1: 0 
IPFast Key2: 0 
Max Attempts: 0 
  
(*) Insight requires these settings to enrol the panel. Note them down. 
 

5. Make CT001 idle then active. 

Internal Modem Setup 
If you want to use the internal modem: 
 

1. Change CT002 from active to idle 
2. Change CT002 to IModem 
3. Press help > 9, and make sure the following settings are selected: 

 
Rings to answer = 15 
All other options = default (no / blank) 
 

4. Make CT002 active. 
5. In CT001, make sure Int. Mod = ....nACE and restart CT001. 

 

                                                     
1 Pick a random or sequential number for each panel. The number must be unique for all panels 
in your Insight installation. 

If you don’t intend to use a direct serial 
connection, set these flags to nnnn. 

For direct serial connections: if you are using a 
DTR/DSR comms cable, you can set opts to nYnn. 
This stops phantom mouse detection on older 
PC’s. Most cables do not have DTR/DSR 
connected, and will not work with this option. 

To secure your installation, set these to random 
values. They must match the settings on page 21. 

If you are using the internal modem, then set 
these flags to ....nACE. 
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